# Table of Contents

**COURSE OVERVIEW** .................................................................................................................... 3

- Discussion ......................................................................................................................... 3
- Course Objectives .............................................................................................................. 3

**LESSON 1: GET STARTED WITH NOLIJ WEB** ........................................................................ 4

- Topics ..................................................................................................................................... 4
- Get Help with Nolij Web ...................................................................................................... 5
- Login/Logout
  - Login .............................................................................................................................. 6
  - Logout .............................................................................................................................. 8
- Change Roles ...................................................................................................................... 9
- Record Retention .............................................................................................................. 10

**LESSON 2: SELECT PREFERENCES** ..................................................................................... 11

- Discussion .......................................................................................................................... 11
- Select the Theme (Colors) ................................................................................................. 12
- Search Preference ............................................................................................................ 13

**LESSON 3: INQUIRY** ......................................................................................................... 15

- Discussion .......................................................................................................................... 15
- Topics ..................................................................................................................................... 15
- Terminology ........................................................................................................................ 16
- Review the Window ........................................................................................................... 17
- Search for a Student’s Folder ............................................................................................. 18
- Review the Documents in a Student’s Folder ...................................................................... 19
- Columns Displayed ............................................................................................................ 23
- View Form Data ................................................................................................................ 25
- Begin a New Search .......................................................................................................... 27
- Clear the Query Results .................................................................................................... 29
- Search for Documents by Index Type .............................................................................. 32
- Create Favorite Folders ..................................................................................................... 33

**LESSON 4: WORK WITH DOCUMENTS** ............................................................................. 34

- Discussion .......................................................................................................................... 34
- Topics ..................................................................................................................................... 34
- File Explorer – Copy a Document ...................................................................................... 35
- Index Documents (Name Documents) ............................................................................... 38
- Annotations ........................................................................................................................ 40
- To Print a Document
  - Use the Print Tool in the Document Viewer ..................................................................... 41
  - App Activation ................................................................................................................ 42
- E-mail a Document ............................................................................................................ 43
LESSON 5: SCANNING ........................................................................................................ 46

DISCUSSION .................................................................................................................... 46

TOPICS ............................................................................................................................ 46

SCAN A SINGLE PAGE DOCUMENT .................................................................................. 47

SCAN A MULTI PAGE DOCUMENT ................................................................................... 48

SCAN USING BLANK PAGE DETECTION ............................................................................ 50

STAPLE (MERGE) DOCUMENTS ....................................................................................... 52

RESCAN A PAGE .............................................................................................................. 54

INSERT A PAGE OR PAGES ............................................................................................ 55

APPEND PAGES ................................................................................................................ 56

MODIFY SCANNED IMAGES ........................................................................................... 57

MOVE DOCUMENTS BETWEEN FOLDERS ...................................................................... 58

APPENDIX A: COMMUNICATION PANEL ........................................................................ 59

APPENDIX B: USE THE UANET VPN ........................................................................... 60

APPENDIX C: SAVE AN EMAIL TO A STUDENT’S FOLDER IN NOLIJ ......................... 61

APPENDIX D: EDIT A DOCUMENT .................................................................................. 65

Discussion ......................................................................................................................... 65

Add a Document from a Template .................................................................................. 66

Edit an Existing Office Document in Internet Explorer .................................................. 67

Edit an Existing Office Document in Firefox in Windows XP ....................................... 70

Edit an Existing Office Document in Firefox in Windows 7 ......................................... 74

View Older Versions of a Document .............................................................................. 77

Rollback to an Earlier Version of a Document ............................................................... 79
Course Overview

Discussion

Nolij Web is a document imaging software application. Document imaging is the online storage, retrieval and management of electronic images of documents. The main methods of capturing images are scanning paper documents and copying electronic documents.

The University is using Perceptive Nolij Web (Nolij Web) to image, annotate, retrieve and manage our large volume of documents. Most of these documents are originally in paper form, are scanned into Nolij Web and saved electronically to a folder for a particular student, employee, alumnus, friend of The University or business entity. Some of the documents in Nolij Web are created originally in electronic form, such as a Word document, and are copied to Nolij Web.

At this writing, The University has realized the following benefits:

- Better student service through immediate access to student files and no lost or misplaced files
- Increased staff productivity through faster storage, retrieval, analysis, and management of document information
- A more collaborative environment through both the consolidation of information from many sources and the immediate sharing of data with other campus users

Course Objectives

In this course, you will learn:

- How to get started with Nolij Web
- How to get help
- To efficiently use the Nolij Web interface for inquiries
- To efficiently use the Nolij Web interface for scanning
Lesson 1: Get Started with Nolij Web

In this lesson, you will learn about resources at The University of Akron that are available to you, as you begin to use Nolij Web.

Topics

- Get help with Nolij Web
- Login and logout
- Change roles
- Record retention

Note: If you will be accessing Nolij Web using the wireless network on campus, VPN software needs to be installed on that laptop. Contact the Support Desk at x6888 for assistance or view the Support Wiki at http://support.uakron.edu/wiki/index.php/Vpn.
## Get Help with Nolij Web

<table>
<thead>
<tr>
<th>Contact Type</th>
<th>Comments</th>
<th>Contact</th>
</tr>
</thead>
<tbody>
<tr>
<td>IT Contact</td>
<td>Resource person for departmental setup and technical issues</td>
<td>Matthew Bungard&lt;br&gt;<a href="mailto:mrb3@uakron.edu">mrb3@uakron.edu</a>&lt;br&gt;X6663</td>
</tr>
<tr>
<td>Help by Phone</td>
<td>For problems/questions about using Nolij Web and changes to departmental setup</td>
<td>Support Desk&lt;br&gt;X6888</td>
</tr>
<tr>
<td>Record Retention</td>
<td>The University of Akron is required to comply with the Ohio Public Records Act. Electronic records and hard copy records must comply with the law.</td>
<td>James Hilliard, University Records Manager&lt;br&gt;<a href="mailto:jnh1@uakron.edu">jnh1@uakron.edu</a>&lt;br&gt;x8182&lt;br&gt;S. Victor Fleischer, UL Archival Services&lt;br&gt;<a href="mailto:svfleis@uakron.edu">svfleis@uakron.edu</a>&lt;br&gt;x6253&lt;br&gt;Scott Campbell, Assistant General Counsel and Records Compliance Officer&lt;br&gt;<a href="mailto:smc4@uakron.edu">smc4@uakron.edu</a>&lt;br&gt;x7226&lt;br&gt;Records Retention documents at: General Counsel’s website <a href="http://www.uakron.edu/ogc/legal-policies-and-procedures/records/records-retention.dot">http://www.uakron.edu/ogc/legal-policies-and-procedures/records/records-retention.dot</a></td>
</tr>
<tr>
<td>Student Records – FERPA</td>
<td>The University Registrar is the FERPA (Family Educational Rights and Privacy Act) coordinator.</td>
<td>Office of the Registrar&lt;br&gt;<a href="mailto:Registrar@uakron.edu">Registrar@uakron.edu</a>&lt;br&gt;X8300&lt;br&gt;FERPA (Family Educational Rights and Privacy Act) online training is accessible on the Faculty/Staff tab of My Akron.</td>
</tr>
<tr>
<td>Training</td>
<td>Seminar and documentation for an introduction to Nolij Web inquiry and scanning</td>
<td>Pam Rodehaver&lt;br&gt;<a href="mailto:rodehav@uakron.edu">rodehav@uakron.edu</a>&lt;br&gt;x2388&lt;br&gt;Sue McKibben&lt;br&gt;<a href="mailto:smf@uakron.edu">smf@uakron.edu</a>&lt;br&gt;x6391&lt;br&gt;Go to <a href="http://www.uakron.edu/training">http://www.uakron.edu/training</a> for additional documentation.&lt;br&gt;Go to <a href="https://www.uakron.edu/seminars">https://www.uakron.edu/seminars</a> to register for a seminar.</td>
</tr>
</tbody>
</table>
Login/Logout

Login

The installation of client software on your PC is not required for Nolij Web 6.7. However, the Nolij VPN software is required for wireless users. If necessary, contact the Support Desk at x6888 to request the Nolij VPN software.

Users can login to Nolij Web multiple times. This means that you are able to login to Nolij Web on more than one computer at the same time or more than once on a single computer.

1. Open a web browser.
   Nolij Web 6.7 is compatible with most web browsers.

2. Navigate to Nolij Web 6.7 at The University of Akron:
   https://imaging.uakron.edu
   The login page displays.

3. Read the security and confidentiality message.

4. If this is the first time that you are accessing Nolij Web 6.7, a shortcut may be created on your desktop. From the menu in Internet Explorer, select File > Send > Shortcut to Desktop.

5. Enter your UAnet ID and password.
6. Click **Login**.

- A prompt, similar to this, may display. Click to mark the checkbox and click on Run.

```
Do you want to run this application?
Name: fileSystemApplet
Publisher: Perceptive Software
This application will run with unrestricted access which may put your computer and personal information at risk. Run this application only if you trust the publisher.

[ ] Do not show this again for apps from the publisher and location above

More Information  [Run]  [Cancel]
```

- You are logged in to Nolij Web with your default role.

**The role determines what can be viewed and the tasks that can be performed.**

You may have more than one role.

- The Nolij Web window displays.

The first time that you login, the window looks like this:

Your role is listed here. To change roles, click on the down arrow and make a selection.

**When you change roles, the search and query results areas are cleared.**

- Click on the **Workflow/View** tool to select a view. Nolij Web remembers the choice for future logins.
## Logout

1. It is best practice to remove any student folders from the Query Results area by clicking on the Clear Query Results tool in the Query Results header.

   ![Clear Query Results](image)

   UA Person Query (No SSN) 1
   1229982, STUDENT, JOSEPHINE, Jun-

2. It is best practice to click on the Clear Query Fields tool on the Workflow header to clear the Search area.

   ![Clear Query Fields](image)

   Workflow: ADM Process

   However, it is not required.

3. Click on **Logout**.

   ![Logout](image)

   You are logged out of Nolij Web and the login page displays.
## Change Roles

When roles are changed, you are logged out of Nolij and logged in with the new role that you selected.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
</table>
| 1. | If the current role is not the role you need in order to complete your work, click on the down arrow of the Role tool.  
   | Academic Advisors - University College  
   | Be certain that your current work is completed.  
   | When you change roles, the search and query results areas are cleared. |
| 2. | Select the correct Role.  
   | The Search area and Query Results are cleared.  
   | The Nolij Web window refreshes.  
   | Your role is changed. |
Record Retention

Whether a student record is in hard copy or is stored electronically, the rules of The University and all legal requirements must be followed and met. If you have questions regarding records retention, contact the University Records Manager, UL Archival Services or the Records Compliance Officer. Their contact information is on page 5 of this manual.

Important documents concerning Records Retention are available at General Counsel’s website: http://www.uakron.edu/ogc/.

- Under University Rules at a Glance, click on the link Search for rules.
- Click on the tab for Keyword Search.
- Search by keywords “records retention.”
Lesson 2: Select Preferences

Discussion

Select the Theme

The colors of the Nolij Web window may be selected. Caution: Changing themes will clear the work area.

Search Preference

When a search for a student folder is done, select a preference to either:

- Clear all results before each query
- OR -
- Stack the students’ folders in the Query Results area
# Select the Theme (Colors)

The theme is the set of colors used in the Nolij Web window.

<table>
<thead>
<tr>
<th>1.</th>
<th>Complete any current work that you are doing in Nolij Web. <strong>When a new color theme is applied, the folders and documents on which you were working are closed.</strong></th>
</tr>
</thead>
</table>
| 2. | Click on the Tools menu button. ![Tools Menu](image)  
A short list displays. |
| 3. | From the list that displays, point to Themes.  
A list of color choices displays.  
The current theme is indicated by a checkmark. ![Themes List](image) |
| 4. | From the list, select a color theme to use.  
A Warning dialog box displays. ![Unsaved Changes](image)  
**Unsaved Changes**  
If you change themes, unsaved changes will be discarded. Save any changes you want to keep before you change themes.  
Do you want to continue changing themes?  
[Yes] [No] |
| 5. | **See the Caution note in step 1 before selecting Yes or No.**  
To apply the new color theme, click Yes.  
The window refreshes with the new colors displayed. |
# Search Preference

When searches for student folders are done, select a preference to either:

- Clear all results before each query
- Stack the students’ folders in the Query Results area

1. Click on the down arrow on the Query Results header.

   ![Screenshot of query results interface](image)

   A list of options displays.

   - Clear All Results Before Each Query
   - Expand All Results
   - Collapse All Results
   - Clear All

2. **To clear** the existing Query Results (folders), when a new search is done, ensure that the checkbox is marked for Clear All Results Before Each Query.

   **To keep** the existing Query Results (folders), when a new search is done (i.e. stack the folders), unmark the checkbox for Clear all Results before Each Query.

   In class, unmark the checkbox. This will “stack” the student’s folders in the Query Results area.
3. Examples:

- The query results (search results) for EmplID 1229982 display like this:

  ![Screen Shot](image1)

- A search is completed for EmplID 1235635. If the box to Clear All Results Before Each Query is marked, the display is:

  ![Screen Shot](image2)

  If the box to Clear All Results Before Each Query is not marked, the display is:

  ![Screen Shot](image3)
Lesson 3: Inquiry

Discussion

In this lesson, you review elements of the Nolij Web window, search for a student’s folder, and review the images that are stored in that folder.

Topics

► Terminology
► Review the window
► Search for a student’s folder
► Review the documents in a student’s folder
► Columns displayed
► View Form data
► Begin a new search
► Clear the query results
► Search for documents by index type
► Create favorite folders
**Terminology**

Each student with a PeopleSoft ID has a **folder** in Nolij Web.

The documents stored in the student’s folder are called **folder objects**.

When a department/college places a document in a student’s folder, the document is **indexed** (named) by that department/college.

The selected name of the document is referred to as an **index type**.
## Review the Window

1. **PeopleSoft Search** – to locate the student’s folder
   Admissions users with the appropriate permissions also will see fields to search the Gray Folders.

2. **Query Results** – the PeopleSoft Search results. Select a student’s folder here.

3. **Folder Objects** – the documents available for the selected student folder

4. **Document Viewer** – a view of the document that is selected in the Folder Objects area

5. **File Explorer** – to locate documents on your computer to be copied to the selected student’s folder

6. **Form** – displays PeopleSoft data about the selected student
   Click on the Expand/Collapse tool on the Form header to view the form and the data.

---

©2014 These materials may not be reproduced in whole or in part without the express permission of The University of Akron.
Search for a Student’s Folder

For the most frequent methods used to search for a student’s folder, enter:
- The student’s ID
- OR-
- Last Name and First Name (Partial values are allowed.)

The (Home) Address Line 1 and Date of Birth fields also are available for searching.
The Social Security Number field is no longer available to most users. To submit a request for access to the SSN, please contact the Support Desk at x6888.

Your role determines the search fields that are available to you.

Nolij Web can return the first 100 results that match the criteria entered.

1. In the PeopleSoft Search Area, enter the search criteria.

   In class, enter the student ID **1229982** and press the ENTER key on the keyboard.

   The student’s folder displays in the Query Results area.

2. **Notes:** Any of the displayed search fields can be used to enter criteria.

   The PeopleSoft wildcard character, % (percent sign), can be used. The wildcard character is used, when you only know a partial, rather than whole field value.
   
   **For example:**
   
   To search for Judi or Judith or Judy Miller, the criteria could be:

   To search for Judi or Judy or Judith Miller, who lives on Boneta Road or Street, the criteria could be:

   (The Address field searches the Home address only. It is a case sensitive field.)

   Use title case (initial capital letters for each word).

3. Review the Query Results area to see the student folder(s) that match the search criteria.
Review the Documents in a Student’s Folder

1. Click once on the student folder to select it and to see:
   - The names of the Folder Objects (documents) that are available for that student.
   - Additional PeopleSoft data displayed in the PeopleSoft Search area and the Form area. See page 25 to review and to work with the Form.

2. **Note**: The first user on campus to select and open a document/student’s folder is able to edit the document or add documents to that folder, if the user has the appropriate security. All other users who select the document/student’s folder can view the documents for which they have security, but they cannot edit or add documents. These users receive a message that displays in the center of the Nolij Web window that notifies them of this and of the UAnet ID of the person who has the folder for editing.

   This is similar to when three people in your office open the same Word document from the H: drive. The first person can edit the document, but the other two people receive the read-only message.

   A message displays in the Folder Objects header to notify you that a file/folder is locked.
3. At the bottom of the Folder Objects area, there are Page tools available, if the document list is longer than one page.

Use these tools to move to the first, previous, next and last pages of the list of documents in the Folder Objects area or to refresh the list of documents. Point to a tool to display its function.

4. In the list of folder objects, the font color used for a document’s name is meaningful.

- Black – The document belongs to your Department/College.
- Red – This is a shared document that belongs to another Department/College, but is shared for viewing by your Department. Some of the documents that are shared across all colleges are:
  - Interview records for Advising areas
  - Admissions documents
  - Transfer documents
- Blue – The document is stored in a subfolder. Sub folders are used by a Department to make it easier to locate frequently used and/or key documents.

**Note:** In general, the name of a document identifies which Department/College owns the document. For example, a document with a name that begins with UC belongs to University College, with SC belongs to Summit College.

The exception to this naming convention is Undergraduate Admissions.
5. In the Folder Objects area, click once on a document’s name to display the document in the Document Viewer.

6. To move from page to page in the displayed document:
   - Use the Page tools in the Document Viewer toolbar.
   - Use the mouse wheel.

7. When an entire page does not display in the viewer:
   - Use the Hand tool to “grab” the page and move it within the viewer.
   - Use the scroll bar on the right side of the Document Viewer.
   - Use the Zoom, Fit Width, and Fit Page tools in the Document Viewer toolbar.

8. On the Document Viewer toolbar, tools are available to modify the size of the Document Viewer area.
   - Click on the Maximize tool in the Document Viewer toolbar.
9. Note the changes in the Nolij window when the Document Viewer area is maximized. The File Explorer and Search, Results, and Folder Objects areas are hidden.

10. To return the Document Viewer area to its previous size and return to the main Nolij Web window, click on the **Restore tool**. The Document Viewer is returned to its normal size in the Nolij Web window. The File Explorer and Search, Results and Folder Objects areas display.
## Columns Displayed

You may select the columns of information that display with the document name.

<table>
<thead>
<tr>
<th>Type</th>
<th>Name</th>
<th>Created</th>
<th>Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td>UC Correspondence</td>
<td>2013 Jul 31 15:24</td>
<td>2013 Jul 31 15:24</td>
<td></td>
</tr>
<tr>
<td>UC Other</td>
<td>2013 Jul 25 11:38</td>
<td>2013 Jul 31 14:47</td>
<td></td>
</tr>
<tr>
<td>UC Intake Prep</td>
<td>2013 Jun 6 13:45</td>
<td>2013 Jul 31 14:47</td>
<td></td>
</tr>
</tbody>
</table>

1. In the Folder Objects area, point to the blank area to the left of the column headers. A down arrow displays.

2. Click on the down arrow.

3. Point to (do not click on) **Columns**. A list displays of available columns.

   The Type column displays an icon that indicates the application in which the document was created, e.g. Word or Adobe Pro.
4. Click to mark the checkbox for the columns to display. The column display reflects the changes.

```
<table>
<thead>
<tr>
<th>All</th>
<th>Adviser Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Name</td>
</tr>
<tr>
<td>UC Other</td>
<td>2012 Dec 12 10:36:46</td>
</tr>
<tr>
<td>UC Correspondence</td>
<td></td>
</tr>
</tbody>
</table>
```

Press the ESCape key on the keyboard to exit the columns menu.

The Folder Objects area may need to be resized to see the selected columns.

**Note:** To resize the Folder Objects area:
Place the mouse pointer on the right border of the area. With the mouse pointer as a double-headed arrow , drag the border until the area is the appropriate size. It may be necessary to adjust the Query Results area, as well.
View Form Data

When a student folder is selected in the Query Results area and the Form is opened, data from PeopleSoft about that student populates the Form in Nolij Web. The Form may be detached as a separate box that can be dragged to display in other areas of the Nolij window.

1. In the Query Results area, click to select the student’s folder.
2. At the bottom right of the Nolij Web window, click on the Expand tool on the Form header.

   The Form expands. There is a pause as the PeopleSoft data is retrieved.

3. To hide the Form, click on the Collapse tool.
4. Click once on the student folder to select it and to see:
   - The names of the Folder Objects (documents) that are available for that student.
   - Additional PeopleSoft data displayed in the PeopleSoft Search area and the Form area.

   Use the scroll bar to view additional data in the Form.

   Point to a row of data in the form to see the row values displayed in a list format.

   Form list – Click on the down arrow to select a form for which you have security.

   Form Area with Form data displayed
5. When viewing a document, the Form may be detached and moved to another part of the window.

To detach the form:
- Follow the instructions in steps 1 and 2 above to view the Form.
- Click on the Detach tool.

The Form will display as a floating window.
- Place the mouse pointer on the Form header bar and drag the Form to another location. Nolij Web will remember the location and size of the Form, so that the next time you select the Detach tool, the Form will display in that same location and in the same size.

6. The size of the Form may be modified by placing the mouse pointer on the Form’s boundaries. When the mouse pointer displays as a double-headed arrow, drag to resize the Form.

7. To reattach the Form, click on the Form box close tool.
Begin a New Search

When you begin a new search, one choice you make is whether to:

- **Clear** the existing Query Results (student folders).
- **OR**
- **Keep** the existing Query Results (student folders).

1. Click on the down arrow on the Query Results header.

   A list of options displays.

   - Clear All Results Before Each Query
   - Expand All Results
   - Collapse All Results
   - Clear All

2. **To clear** the existing Query Results (folders), when a new search is done, ensure that the checkbox is marked for Clear All Results Before Each Query.

   **To keep** the existing Query Results (folders), when a new search is done (i.e. stack the folders), unmark the checkbox for Clear all Results before Each Query.

   In class, unmark the checkbox. This will “stack” the students’ folders in the Query Results area.

3. To clear the PeopleSoft search area, click on the Clear Query Fields tool in the Workflow header.

4. Enter the new criteria to locate a student’s folder.

   In class, clear the number in the ID field of the Search area and type the EmplID **1813884**.
5. Press the ENTER key on the keyboard. The search is completed and the search results display in the Query Results area.

The results from the previous search (1229982) remain in the query results, in addition to the new query results for 1813884. This occurs because the option to Clear all results before each query was turned off (unmarked) at the down arrow.

6. Click on the Clear Query Fields tool in the Workflow header to clear the PeopleSoft search area.

Only the Search area is cleared. The Query Results are not cleared.
Clear the Query Results

There are several options for clearing query results.

- Clear all the query results.
- Clear a single set of query results.
- Clear only unlocked query results.
- Keep all the query results.

To prepare for this lesson, search for MILLER, MICHAEL with a date of birth range of 01/01/1990 to 12/31/1990. In Nolij Web, it is necessary to enter dates in the mm/dd/yyyy format, e.g. 01/01/1990. Enter the forward slashes.
1. To clear a single query’s results:
   - Right click on the query’s header. (The header contains the words Person Query.) In this example, right click on Person Query 2. A list displays.
   - Select Clear Result from the list. Only that query’s results are cleared. All other query results are kept.

2. To clear only unlocked query results:
   - Lock any query results that are to be kept (not cleared):
     - Right click on the query’s header. (The header contains the words Person Query.) In this example, right click on Person Query 1. A short list displays.
     - Select Lock Query Results from the list that displays. A lock icon displays in the Person Query header.
   - Click on the Clear Unlocked Results tool in the Query Results header.
   Only the unlocked Query Results are cleared. The locked results remain.
3. **To clear the results of a locked query:**
   - Right click on the query’s header and select Unlock Query Results from the list that displays.
   - Right click on the query’s header, again, and select Clear Result.

4. **To automatically clear the Query Results, when a new search is completed:**
   - Click on the down arrow in the Query Results header.
   - In the list that displays, click to mark the checkbox for Clear All Results before each query.

5. **To clear all the unlocked Query Results at any time:**
   - Click on the Clear Unlocked Results tool in the Query Results header.
   - The unlocked Query Results are cleared.

6. **To clear all Query Results, locked and unlocked:**
   - Click on the down arrow on the Query Results header.
   - Select Clear All.
Search for Documents by Index Type

If the list of documents in a student’s folder is lengthy, use the Filter On option on the down arrow of the Folder Objects header to view only those documents that are a particular index type (name).

To prepare for this lesson in class, search for the student, whose ID is on the yellow sheet of paper on your keyboard. Click once on the student’s folder to select it and view the list of documents in the Folder Objects area.

**Note:** The Filter On option is not available if the folder is locked.

1. Use the Filter On option on the down arrow of the Folder Objects header to select Index Type

   ![Filter On](image)

   A Filter by box displays below the Folder Objects header.

   Index Type is the document’s name.

2. Click on the down arrow next to All to display a list of the index types.

3. Select an index type (document name). **Wait.**
   A list of the selected student’s documents with that index type displays.
   All other documents for that student are hidden from the document list.

4. To search for another index type in that student’s folder, repeat steps 2 and 3.

5. To view all the documents in a student’s folder, select All from the list at the down arrow.

6. To remove the Filter box from the display, click on its X.
## Create Favorite Folders

Favorites for folders are available. When a folder is marked as a favorite, it will display at the top of the Query Results, whenever you log in to Nolij and until it is removed as a favorite. If you have multiple roles, the favorite is associated with the role in which it was created. The favorite displays only when you login and use that role.

1. In the Query Results, click once on the student’s folder to select it.
2. Right click on the folder.
3. Select Add Favorite from the list.
4. The Favorite Folders list displays with your favorite folders.
5. When the Clear Unlocked Results tool is used, the Favorite Folders are not cleared.
6. To remove a folder from the Favorite Folders list:
   - Click on the folder to select it.
   - Right click on the selected folder to display the shortcut menu.
   - Select Remove Favorite.
Lesson 4: Work with Documents

Discussion

When reviewing the documents in the student’s folder, you may need to copy a document from your computer to the student’s folder in Nolij or to print the document. In this lesson, you review how to complete these tasks.

Remember that your role determines what you can see and do in Nolij Web.

Topics

- File Explorer – Copy a document
- Index documents (name documents)
- Annotations
- Print a document
- E-mail a document
File Explorer – Copy a Document

The File Explorer is divided into two columns, when expanded. It is used to search for files on your computer and to copy the files to the student’s folder in Nolij Web. The File Explorer is similar in appearance to Windows Explorer.

When a folder is selected in the left column, the file objects that are stored in that folder display in the right column.

In the example shown here, the Desktop\Desktop Files 2013 folder is selected in the left column. The files that are stored in that folder are displayed in the right column.
1. In the Query Results area, select the student’s folder in which to place the document.

2. To display the File Explorer, click on the expand tool on its header.

3. In the File Explorer, click on a folder to expand it and to view the files and subfolders that it holds.
4. Navigate to and select the document to copy to the selected student’s folder in Nolij Web.

5. To copy the document to the student’s folder in Nolij:
   - Place the mouse pointer on the file’s icon in the File Explorer.
   - Drag the file to the Folder Objects area in Nolij and drop it.

   ![Image of File Explorer]

   The mouse pointer displays as shown below.

6. By default, the copied document is listed at the bottom of the Folder Objects list. To sort the documents so that the newest document is at the top of the list, point to the Modified document header and select Sort Descending at the down arrow that displays.

   ![Image of Folder Objects list]

7. To hide the File Explorer, click on the Collapse tool.

   ![Image of Collapse tool]
# Index Documents (Name Documents)

1. Click on a document icon to select the document.

2. Right click on a document’s icon in the Folder Objects area. A shortcut menu displays.

   ![Shortcut menu](image)

3. If the index type needed is not on the menu, select either the Choose Index Type or More Index Types option. A box displays with a list of all the document index types to which you have access.

4. Select an index type and click on OK.
5. To index a document and add the index type to the shortcut menu, at the same time:

- Click on the document’s icon in the Folder Objects area to select it.
- Right click on the document icon to display the shortcut menu.

  **Note:** This document should need the index type to be locked or already have the index type to be locked.

- Select More Index Types from the menu. A box displays.
- Right click on an index type (name) and select Lock.

![Choose Index Type]

A lock displays to the right of the selected index type.

- Click on OK.

  The Index Type is added to the shortcut menu that displays when you right click on a document.

  The selected document is indexed with the selected Index Type.
## Annotations

The Annotation tools are available from the Document Viewer toolbar.

If the Annotation tool is not displayed, click on the More tool to select it.

If you have the permissions to annotate a document, you may highlight areas of a document or add a sticky note, for example. Annotations are stored separately from the document in Nolij Web. **This allows the document to be viewed or printed with or without the annotations.**

1. In the Folder Objects (document list), click once to select the document to view and annotate.
2. In the Document Viewer toolbar, click on the Annotations tool to display and select an annotation type.

   ![Annotation Tool Options](image)

   The Stamp annotation type only is available if your department has a stamp created for its use.

3. On the document, drag to draw the annotation shape.
4. Right click on a drawn annotation to display a menu that includes deleting the annotation or changing its properties.
5. When you are done using an annotation option, click on the Selection tool on the Document Viewer toolbar.
6. To Hide or show the annotations for a document:
   - Select the Annotation tool.
   - Use the Hide checkbox. Click to mark the Hide box to hide the annotations or unmark the Hide box to show the annotations.
7. On the Document Viewer toolbar, use the Save tool to save any changes that are made.

**Note:** To move or resize an annotation, use the Selection tool.

---

Ver. 2014.03.10

©2014 These materials may not be reproduced in whole or in part without the express permission of The University of Akron.
To Print a Document

One of the reasons for using Nolij Web is to reduce paper consumption, while allowing efficient access to student records. Consider whether a hard copy of a document is necessary before printing.

Use the Print Tool in the Document Viewer

The preferred method for printing a document is to use the Print tool on the Document Viewer’s toolbar.

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Click once on the document’s name to select it. The document displays in the Document Viewer.</td>
</tr>
<tr>
<td>3.</td>
<td>To view the Adobe toolbar, move the mouse pointer toward the bottom of the document in the Adobe window.</td>
</tr>
<tr>
<td>4.</td>
<td>Select the Print tool in the Adobe Reader toolbar. The Print dialog box displays.</td>
</tr>
<tr>
<td>5.</td>
<td>Make your selections and click Print.</td>
</tr>
<tr>
<td>6.</td>
<td>Close the Adobe window.</td>
</tr>
</tbody>
</table>
**App Activation**

For Microsoft® Office documents, another method for printing a document is to activate the application from which the document was created. Then, use the File > Print or Office Button > Print command in the application.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>In the Folder Objects (document list), click once on the document’s name to select it.</td>
</tr>
<tr>
<td>2.</td>
<td>Double click on the document’s icon in the Type column.</td>
</tr>
<tr>
<td>3.</td>
<td>If the following message displays, select Open.</td>
</tr>
</tbody>
</table>

**Wait.** The application, in which the document was created, is opened with the document displayed. For example, Word would open to display a document that was created in Word.

The document is opened read-only and cannot be edited.

**Note:** Annotations will not display or print. To print a document with its annotations, use the Print tool in the Document viewer toolbar in Nolij.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In Office 2010, select File &gt; Print.</td>
</tr>
<tr>
<td>5.</td>
<td>Make your selections and click OK or Print.</td>
</tr>
<tr>
<td>6.</td>
<td>Close the application window, when your work is complete.</td>
</tr>
</tbody>
</table>
E-mail a Document

The documents may contain sensitive information about a student.


3. A separate, Adobe Reader window opens and the document displays.

4. Move the mouse pointer toward the bottom of the Adobe Reader window to display the Adobe toolbar.

5. Click on the Show Acrobat toolbar tool.

The expanded toolbar displays at the top of the Acrobat Reader window.
6. Click on the Share Files tool \[\text{外}\].
The Send Files task pane displays.

7. Select Attach to Email.

8. The Select File value will default to the displayed document.

9. Click on \[\text{外}\].
An Adobe Acrobat dialog box displays.

10. Select \[\text{发抄件} alter\[\text{外}\].
Note: See the information on the next page about using the Send Link option.
11. Your default mail application will open. On campus, usually, this is Outlook. The document will be attached to the email in a PDF format. The name of the attachment will be PrintFile.pdf.

Notes: If the Send Link option is used, a link is created in the email message as shown here. However, the link only will work if the mail recipient first logs in to Nolij and then clicks on the link. For the link to work, Nolij needs to be open, but it is not necessary to open a student’s folder.

Alternatively, you may App Activate certain documents. Then, within that application, use the Attach to Email or Send or Save & Send commands to email the document. The Attach to Email or Send or Save & Send commands are located on the application’s File menu or on the Office Button menu.
Lesson 5: Scanning

Discussion

The scanning process is reviewed in this lesson. Although your job duties may not require that you scan documents, it is beneficial to understand the process.

Topics

- Scan a single page document
- Scan a multi-page document
- Scan using blank page detection
- Staple (merge) documents
- Rescan a page
- Insert a page or pages
- Append pages
- Modify scanned images
- Move documents between folders
Scan a Single Page Document

1. In the Query Results, click on the student folder that is to hold the scanned document.

2. If the document is to be placed in a subfolder, click on the subfolder in the Folder Objects area.

3. Click on the Scan tool in the Folder Objects header.

   ![Scan tool screenshot]

   **Note:**
   The Scan tool displays in the header only after a student’s folder is selected. The Scan tool displays only if your role has permission to scan.

4. At the beginning of each log in session, a prompt may display to select a default scanner, when the Scan tool is selected for the first time. Select a scanner.

   ![Default scanner selector]

   The scanner dialog box displays.

5. Make the appropriate selections in the Scanner dialog box.

   ![Scanner dialog box]

   Your scanner’s dialog box may be different than the one shown here.

6. The document is scanned into the student folder and stored on the Nolij Web server. By default, the document displays at the end of the document list.

7. In the Folder Objects area, right click on the document to index it.

8. Review the document in the Viewer to verify that it is legible.
Scan a Multi Page Document

1. In the Query Results, click on the student folder that is to hold the scanned document.

2. If the document is to be placed in a subfolder, click on the subfolder tab in the Folder Objects area.

3. Click on the down arrow of the Scan tool in the Folder Objects header and mark the Multi Page checkbox.

   ![Scan tool screenshot]

   **Note:**
   The Scan tool displays on the header only after a student's folder is selected. The Scan tool displays only if your role has permission to scan.

4. Click on the Scan tool to begin scanning.

5. At the beginning of each log in session, a prompt displays to select a default scanner, when the Scan tool is selected for the first time. Select a scanner.

   ![Scanner dialog box]

   The scanner dialog box displays.

6. Make the appropriate selections in the Scanner dialog box.

   ![Scanner properties dialog box]

   Your scanner's dialog box may be different than the one shown here.

7. The document is scanned into the student folder and stored as a single document on the Nolij Web Server.
8. In the Folder Objects area, right click on the document to index it. By default the document displays at the end of the document list, unless you have sorted the documents.

9. Review the document in the Document Viewer to verify that it is legible and in order.

Note: If the document is multi paged and the Multi Page checkbox is not selected, each page will scan as a separate document. Use the Staple (Merge) Documents instructions in this manual to staple all the pages into a single document.
Scan Using Blank Page Detection

Nolij Web can detect blank pages, which can function as document separators. Several documents may be scanned at one time to a single folder using a blank page between each document. Nolij detects the blank pages and creates separate documents.

1. Place a blank sheet of paper between each of the documents.

2. In the Query Results, click on the student folder that is to hold the scanned documents.

3. If the documents are to be placed in a subfolder, click on the subfolder tab in the Folder Objects area.

4. Click on the down arrow of the Scan tool in the Folder Objects header and mark the Multi Page checkbox.

   ![Scan Tool](image)

   **Note:**
   The Scan tool displays on the header only after a student’s folder is selected. The Scan tool displays only if your role has permission to scan.

5. Click on the down arrow of the Scan tool and mark the Enable Blank Page Detection checkbox.

6. Click on the down arrow of the Scan tool and select Enable Blank Page Detection > Set Threshold.

   ![Blank Page Threshold](image)

   The Blank Page Threshold dialog box displays.

7. Drag the slider to set the threshold that Nolij Web is to use to determine if a page is blank.

   Even blank pages have dots in the background. Use lower values between 40 and 50 for newer scanners. Select higher values for older scanners.
8. Click OK.
9. Click on the Scan tool.
10. At the beginning of each log in session, a prompt may display to select a default scanner. This prompt displays the first time that the Scan tool is selected. Select a scanner.

The scanner dialog box displays.

11. Make the appropriate selections in the scanner dialog box.

12. The documents are scanned into the student folder and stored on the Nolij Web server. By default, the documents display at the end of the document list, unless you have sorted the documents.

13. Right click on each document to select an index type.
14. Review the documents to verify that they are legible and in order.

**Notes:** The blank pages used as separators are not kept as part of any document. For double-sided documents, Nolij Web does not use blank pages on the back sides of the pages as page separators. These blank pages are considered regular pages and are added to the document.

**Tip:** This function may work best if all the documents in the group are double-sided or all the documents in the group are single-sided.
Staple (Merge) Documents

Documents that are scanned into Nolij are TIFF documents. Follow these steps to staple (merge) multiple documents in TIFF format into one document.

When the Merge Selected option is made, only the stapled document will exist. The original documents are not preserved separately.

Note that the Annotations are preserved.

This process works for TIFF documents –OR- for PDF documents. The documents to be merged must all be TIFF documents or must all be PDF documents.

1. Select the documents in the order in which their pages are to be stapled (merged) to create a single document.
   In the Folder Objects, click to select the first document.
   The selection of the first document is important.
   • It is the document onto which the other documents will be stapled.
   • The name and properties of the document after stapling will be those of the first document.
   • Pages are added to the document in the order in which the documents are selected.

2. Select the second document by holding down the CTRL key and clicking.
   The selected documents are highlighted.

3. Continue to select the documents to be stapled with CTRL + click.
   Remember that the documents will be stapled together in the order in which they are selected.
4. When all the documents to be stapled are selected, right click on one of the selected documents' names. 
A shortcut menu displays.

5. **Select Merge Selected.**

![shortcut menu]

The message “Processing . . . please wait” displays.

When the message no longer displays, the documents have been stapled into a single document. 

The document is indexed with the name of the first document. 

The date created property will be that of the first document.

6. Review the document to verify that it is legible and in order.
Rescan a Page

The Rescan Page option is available on a shortcut menu.

Use the Rescan Page option to rescan and replace a page displayed in the Document Viewer.

1. In the Document Viewer, use the page tools or the mouse wheel to navigate to the page of the document that is to be replaced.

2. In the Document Viewer, right click on the page to be replaced and select Rescan Page from the shortcut menu.

3. At the beginning of each log in session, a prompt may display to select a default scanner, when the Scan tool is selected for the first time. Select a scanner.

4. The selected page in the Document Viewer is removed from the document and the scanned page replaces it. The removed page is no longer available in the student’s folder.

5. Review the document to verify that it is legible and in order.
Insert a Page or Pages

Follow the Rescan Page instructions on the previous page, but scan both the displayed page and any pages to insert before or after it.
## Append Pages

Append means to add pages to the end of the document.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1.</strong></td>
<td><strong>In the Document Viewer, display the document to which pages will be appended.</strong></td>
</tr>
<tr>
<td><strong>2.</strong></td>
<td><strong>In the scanner’s tray, load the pages to be appended to the document.</strong></td>
</tr>
<tr>
<td><strong>3.</strong></td>
<td><strong>Right click on any page of the document and select Scan Append from the shortcut menu.</strong></td>
</tr>
<tr>
<td><strong>4.</strong></td>
<td><strong>At the beginning of each log in session, a prompt may display to select a default scanner, when the Scan tool is selected for the first time. Select a scanner.</strong></td>
</tr>
<tr>
<td><strong>5.</strong></td>
<td><strong>The scanned pages are added to the end of the document.</strong></td>
</tr>
</tbody>
</table>
# Modify Scanned Images

<table>
<thead>
<tr>
<th>Image is upside-down.</th>
<th>Use the Rotate Right or Rotate Left tools. The tools rotate the image 90 degrees at a time, so click on the tool a second time if necessary.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image contains a blank page.</td>
<td>With the blank page displayed in the Document Viewer, click on the Extract tool in the Document Viewer toolbar and select Extract Current Page. Then, select Yes. The extracted, blank page displays in the list of Folder Objects. Right click on the blank page in the Folder Objects area and select your department’s Delete option.</td>
</tr>
<tr>
<td>Image is named (indexed) incorrectly.</td>
<td>Right click on the document’s name in the Folder Objects and select a new index type (name).</td>
</tr>
<tr>
<td>Remove a page from a multi page document.</td>
<td>With the page displayed in the Document Viewer, click on the Extract tool in the Document Viewer toolbar and select Extract Current Page. Then, select Yes. The extracted, blank page displays in the list of Folder Objects. Right click on the blank page in the Folder Objects area and select your department’s Delete option.</td>
</tr>
<tr>
<td>Extract all pages from a multi page document</td>
<td>With the document displayed in the Document Viewer, click on the Extract tool in the Document Viewer toolbar and select Extract All Pages. This option extracts the pages of a multi-page TIFF document, making each page a separate document.</td>
</tr>
</tbody>
</table>
Move Documents between Folders

If a document is in the incorrect student folder, follow these steps to move it.

1. Open the student folder, which incorrectly contains the document. (For instructions on stacking student folders, see the topic Begin a New Search.)

2. Search for the correct student folder. Both of the student folders display in the Query Results area.

3. Drag the document to be moved from the Folder Objects area to the correct student’s folder in the Query Results area and drop it.

4. Verify that the document has been moved.
Appendix A: Communication Panel

The Communication Panel is used to display messages from Nolij Web. You must have the appropriate permissions to use this panel.

To access the Communication Panel:

1. Click on Tools in the toolbar at the top of the Nolij Web window.

2. Select Communication Window. The window opens.
Appendix B: Use the Uanet VPN

The Uanet VPN is required to connect to Nolij, when using the wireless network on campus. If the UAnet VPN is not on your computer, contact the Support Desk at x6888 for assistance or see the Support Wiki at http://support.uakron.edu/wiki/index.php/Vpn.

To access Nolij Web via UA’s wireless network, follow these steps:

1. Start the Uanet VPN from either a shortcut on your desktop or at:
   Start > All programs > Cisco Systems VPN Client > VPN Client.
2. Select Uanet VPN.
3. Click on the Connect button.
4. In the VPN Client-User Authentication box, enter your UAnet ID and password.
5. Click OK.
   A Cisco VPN icon becomes available in the system tray, which is in the lower right corner of the display. The icon is a padlock.

To disconnect from the Uanet VPN:

1. Logout of Nolij Web.
2. Double click on the padlock icon in the taskbar.
3. In the VPN client window that displays, select Uanet VPN.
   It will have a padlock icon.
4. Click on the Disconnect button.
   The button changes to be the Connect button.
   The status bar at the bottom of the VPN client window says “Not connected.”
5. Close the VPN client window.
Appendix C: Save an Email to a Student’s Folder in Nolij

If an email message should be saved and placed in a student’s folder in Nolij, follow these instructions. Save the message in the MSG format, which is the default format for saving in Outlook. If MSG is unavailable as a choice at Save as type, select the Text only format.

These instructions will save the email message only. If there are attachments to the email message, the attachments must be saved separately.

**Note:** Your security must allow you to add an MSG formatted or TXT formatted document to a student’s folder.

1. With the message displayed:
   - In Outlook 2010, select File > Save As.
   - In Outlook 2007, select the Office Button > Save As.
   - The Save As dialog box displays.

2. Select the drive and folder in which to save the message.
   - The Desktop is an easily accessible location.

3. At File Name, the subject line of the message will default.
   - Enter a new file name, if appropriate.
4. At Save as type, select msg, if the choice is available.

   If msg is not available, click on the down arrow for Save as type and select Text only (.txt).

   ![Image showing Save as type dropdown]

   Note: Mac Mail does not open an MSG file. It can open a text only file.

5. Click on Save.

6. In the Query Results area in Nolij, select the student’s folder in which to place the document.

   ![Image showing Nolij Query Results]

7. To display the File Explorer, click on the expand tool on its header.

   ![Image showing File Explorer expansion]
8. In the File Explorer, click on a folder to expand it and to view the files and subfolders that it holds.

9. Navigate to the document to copy to the selected student's folder in Nolij.

10. To copy the document to the student's folder in Nolij:
    - Place the mouse pointer on the file’s icon in the File Explorer.
    - Drag the file to the Folder Objects in Nolij.
11. In the Folder Objects, click once on the document to select it. By default, the document displays at the end of the document list, unless you have sorted the documents.

Right click on the document’s icon and select the appropriate index type from the list that displays.

If you do not see the index type (name) that you need, select the More Index Types or Choose Index Type option from the list.

12. To hide the File Explorer, click on the Collapse tool .
Appendix D: Edit a Document

Discussion

One common business process on campus is to use a form document that contains text fields of information and notes that are updated on a continuing basis.

In Nolij Web 6.7, annotations may be added to a document, but the document itself can be edited only through versioning. Versioning is the method for editing an Office document.

The steps to edit an Office document differ between the Internet Explorer and Firefox.

Notes:

- Microsoft® Office 2007 or higher is required for the editing of Office documents that are stored in Nolij Web. On a Windows 7 PC, Office 2010 is required for the editing of Office documents.

- If you have an older version of Office on your computer, please contact the Support Desk at x6888 for assistance. You will need to install Microsoft® Office 2007 or Office 2010 on your computer in order to edit documents in Nolij Web.

- A Windows 7 PC has an office globe icon in the lower left corner of the display.

  A Windows XP PC has the Start button in that location.

- It is not necessary to upgrade Office in order to view documents in Nolij Web.
Add a Document from a Template

To make a template (form document) available in Nolij for your department or college, contact the Support Desk at x6888 to have a ticket created to the Nolij team. At this writing, templates in Nolij are Word documents.

Permissions determine who can use a particular template to create a new document in a student’s folder.

1. Select the student’s folder.
2. Click on the down arrow in the Folder Objects header and select Add Template Document.

![Add Template Document](image)

3. Click once to select a template from the list.
   In this example, UC Interview Record is selected.
   The template is added to the student’s folder as a new document.
   **Note:** If you have not sorted the Folder Objects, the new document will be at the end of the list of Folder Objects.
   To sort the documents (Folder Objects), click on the down arrow for the column by which to sort. In this example, the Name column is sorted in Ascending order.

![Sort Column](image)

4. Follow the instructions on the following pages to edit the new document.
   The instructions for editing a document differ between Internet Explorer and Firefox. Follow the instructions that are appropriate for your browser.
**Edit an Existing Office Document in Internet Explorer**

Double clicking on a document’s icon will open the document as read-only in the application in which the document was created. The document cannot be edited by that method.

In Nolij 6.7, **versioning** is used to allow the editing of an Office document, while saving the original document(s). Only the most recent version of a document displays in the student’s folder. The older versions of the document can be viewed on your request through a shortcut menu.

1. **Right click on the document’s icon.**

2. **Select Edit Document from the shortcut menu.**
   
   Note: Versioning in Nolij is done by index type. If a document is not indexed, Nolij will not display the Edit Document command.

3. **When this warning message displays, click on OK.**
4. The document opens in the appropriate application. If the Protected View message displays above the document area (Office 2010), click on Enable Content.

![Security Warning: Macros have been disabled. Enable Content]

The document is available for editing.

5. If this Security Warning message displays, click on No.

![Security Warning: Do you want to make this file a Trusted Document?]

6. In the application:
   - Edit the document.
   - Save the document with the Save tool.
   - Close the document.
7. In Nolij, the Versioning Document dialog displays. Enter a comment, if necessary.

![Versioning Document: UC Alternative Credit Letter](image)

8. Click on OK.

The document is not saved to the student’s folder in Nolij until you click on OK in the Versioning Document dialog box.

The current, edited version of the document is displayed in the Folder Objects (document list) in the student’s folder.
**Edit an Existing Office Document in Firefox in Windows XP**

If your PC has a Start button in the lower left corner of the display, it is a Windows XP computer. The following instructions are for Firefox on your computer.

Note: If your PC has the Microsoft Office globe icon in the lower left corner of the display, it is a Windows 7 computer. Those instructions begin on page 55.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Select the student’s folder.</td>
</tr>
<tr>
<td>2.</td>
<td>Right click on the document’s icon.</td>
</tr>
<tr>
<td>3.</td>
<td>Select Edit Document from the shortcut menu.</td>
</tr>
<tr>
<td>4.</td>
<td>In Nolij, the Versioning Document dialog displays.</td>
</tr>
<tr>
<td></td>
<td>The Next Version field displays the number of the next version of the document that will be created. This field cannot be modified.</td>
</tr>
<tr>
<td>5.</td>
<td>The <strong>URL</strong> field displays the location of the document. Select the text from the URL field.</td>
</tr>
<tr>
<td></td>
<td>You need to select all the text in the URL field.</td>
</tr>
<tr>
<td></td>
<td>Use a <strong>triple click</strong> – OR - use shift and the arrow keys to be certain that the entire text for the location is selected.</td>
</tr>
<tr>
<td></td>
<td>Here is an example of the URL text so that you may see its length:</td>
</tr>
</tbody>
</table>
6. With the URL text selected, copy the URL.  
   On a PC, use CTRL + C. On a Mac, use Command + C.

7. Open the appropriate Office program.

8. Use the File menu or Office button to access the Open dialog box.

9. In the File name field of the Open dialog box, paste the URL that was copied. 
   On a PC, use CTRL + V.

10. The File name contains characters that are not needed and must be deleted. 
    For a Word document, remove all the characters after .docx (or after.doc).
    Original copy:  
    Copy after deleting characters:  
    http://cpi-nolij-01/NolijWeb/dav/9bd17384-0c58-419c-bead-3b631aaf0387.docx

11. If there is a Security Warning, select Enable or Options > Enable this content > OK.
12. The document opens in the application.

13. In the application:
   - Edit the document.
   - Save.
   - Close the document.

14. Return to the Nolij window. The Versioning Document dialog box is displayed. Enter a comment if necessary.
15. Click OK in the Versioning Document dialog box.

The document is not saved to the student’s folder in Nolij until you click on OK in the Versioning Document dialog box.

The document is saved to the Nolij Web database.

Note: Nolij uses **versioning** to allow the editing of an Office document, while saving the original document(s). Only the most recent version of a document displays in the student’s folder. The older versions of the document can be viewed on your request through a shortcut menu.
Edit an Existing Office Document in Firefox in Windows 7

If your PC has the Microsoft Office globe icon  in the lower left corner of the display, it is a Windows 7 computer. These instructions are for your computer.

If your PC has a Start button in the lower left corner of the display, it is a Windows XP computer. Those instructions are on the previous pages.

1. Open the student’s folder, select the document to edit.

2. Right click on the document’s icon.

3. Select Edit Document from the shortcut menu.

The Versioning Document dialog box displays.

At this time, leave this box open and do not click on OK or close the Versioning Document box.
4. The URL field displays the location of the document. Select the text from the URL field.

You need to select all the text in the URL field. Use a triple click –OR- use shift and the arrow keys to be certain that the entire text for the location is selected.

Here is an example of the URL text so that you may see its length:

5. With the URL text selected, copy the URL.
On a PC, use CTRL + C. On a Mac, use Command + C.

6. Open the appropriate Office program.

7. Use the File menu or Office button to access the Open dialog box.

8. Paste the URL in the File Name field.

9. The File name contains characters that are not needed and must be deleted.
For a Word document, remove all the characters after .docx (or after.doc).

Original copy:

Copy after deleting characters:
http://cpi-nolij-01/NolijWeb/dav/9bd17384-0c58-419c-bead-3b631aaf0387.docx
10. Click on Open. **Wait**. The document displays.

11. If the message bar displays a Security Warning, click on **Enable Content**. This will allow the editing of the document.

12. If a Trusted Document message displays, click on No.

13. In the application:
   - Edit the document.
   - Save.
   - Close the document.

14. Return to the Nolij window. The Versioning Document dialog box is displayed. Enter a comment if necessary.

15. Click OK in the Versioning Document dialog box.

   **The document is not saved to the student’s folder in Nolij until you click on OK in the Versioning Document dialog box.**

   The document is saved to the Nolij Web database.
### View Older Versions of a Document

1. In the Folder Objects, click once to select a document.

2. Right click on the document’s icon.

3. Select Properties from the shortcut menu.

   ![Properties Menu](image)

   The Document Properties dialog box opens. The Properties tab displays.

   ![Properties Dialog Box](image)

   The UA.net ID, of the person who created the current version of the document, displays in the Created By field on the Properties tab of the dialog box.
4. Click to select the Version tab.

![Document Properties for UC Interview Record (1493226)](image)

<table>
<thead>
<tr>
<th>User</th>
<th>Version</th>
<th>Date</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>R00EHAV</td>
<td>1</td>
<td>Feb 3, 2011 11:59:43 AM</td>
<td>Original Version</td>
</tr>
<tr>
<td>R00EHAV</td>
<td>2</td>
<td>Feb 3, 2011 11:59:43 AM</td>
<td>PKR</td>
</tr>
<tr>
<td>R00EHAV</td>
<td>3</td>
<td>Feb 3, 2011 12:06:12 PM</td>
<td>PKR</td>
</tr>
</tbody>
</table>

5. Click on the version that you want to View.
(The larger the version number, the more recent the version.)

The buttons at the bottom of the dialog box will activate after you select a version.

6. Click on View.

The document version displays in the Document Viewer.

**This does not make it the current version. This is just a view. The current version does not change.**

7. To view the current version, refresh the window by:
   - Click on another document in the student’s folder.
   - Reselect this document.
**Rollback to an Earlier Version of a Document**

If the current version of a document is incorrect and a previous version of a document is correct, use the Rollback button. This will reset the previous version as the correct and current version.

No version of a document is deleted in the Rollback process.

1. In the Folder Objects, click once on a document to select it.

2. Right click on the document's icon.

3. Select Properties from the shortcut menu.

   ![Properties dialog box](image)

The Document Properties dialog box opens. The Properties tab displays.

4. Click to select the Version tab.

   The UAnet ID, of the person who created the current version of the document, displays in the Created By field on the Properties tab of the dialog box.
5. Click on the previous version that you want to make the current version of the document.

(The larger the version number, the more recent the version.)

The buttons at the bottom of the dialog box will activate after you select a version.

6. Click on Rollback.

A copy of the selected version is made. The copy becomes the current version.

This makes the selected document the current version in the student's folder.

No document is deleted in this process.

7. Click on Close.

8. In the Folder Objects, click once on the document to display it in the Document Viewer.

The rolled back version displays as the current version.